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Introduction 
Welcome to the revised version of the AFIADL CerTest Guide for Test Control Officers! 
This is the second revision we’ve made to the Guide since we began the program. We 
hope that it will prove useful as you work with the program. 

We’ve made several changes that we think will make this more “user friendly.” First of 
all, we’ve created two different guides and a separate acknowledgement for students to 
sign when they test:  

• The Test Control Officer’s Guide 

• The Student Guide 

• Special Instructions to Computer-Based Testing Students 

Each Guide is intended to be self-contained and provide the information needed for both 
Test Control Officers and Students. The “Special Instructions to Computer-Based Testing 
Students” is a separate file that you can use as a master for copying for student use 

We’ve also tried to set up the Guide using front-and-back pages so that you can easily 
remove them from a binder or print only those pages you need at any particular time.  

In addition to posting these Guides on our Web site, we are also posting Adobe Acrobat 
versions so that you may download and print additional copies as needed. 

We would appreciate your comments on the Guides, suggestions for improvement, 
changes, additions, or deletions, as well as information on any errors that may have 
escaped our notice. 

Please send these comments to Steve McCarver: 

via email steve.mccarver@maxwell.af.mil  

or via snail mail to:  
Steve McCarver  
AFIADL/DC (CerTest) 
50 S. Turner Blvd 
Maxwell AFB, Gunter Annex, AL 36118-5643 
 

Thanks for your help! 
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CerTest is an Air Force-owned, interactive, computer-based testing program designed to test, 
evaluate, and certify a student's knowledge of the principles and procedures found in today’s Air 
Force specialties. 
 
If you have any questions, problems, or are in need of assistance, please do not hesitate to call 
the program POCs, listed below.  
 

AFIADL CerTest POC Information 
 

CerTest Project Manager – Curriculum Division 
(Policy, New Users, Downloads, Program Revisions/Updates) 

 
Mr. Steve McCarver  DSN:  596-3174  steve.mccarver@maxwell.af.mil  

 
 

Customer Service 
(Help for CerTest Installation Problems, Error Messages, File Downloads, Answer Sheet 

Manager Program, and the File Transfer Program (FTP) software) 
 
Customer Service DSN: 596-3795/1021   afiadl.customer.service@maxwell.af.mil 
       http://afiadl.custhelp.com 

 
Data Branch 

(For questions about Batch File Processing) 
 
Ms Geraldine Maull  DSN:  596-4640/4628  geri.maull@maxwell.af.mil 
Ms Katrina Boren  DSN:  596-4628/4640  katrina.boren@maxwell.af.mil 
Ms Alice Spano  DSN:  596-5344  alice.spano@maxwell.af.mil 
 

AFIADL Web Master 
(To report problems with the Web Site) 

 
Ms. Evelyn Milton  DSN:  596-3370  evelyn.milton@maxwell.af.mil  
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Getting Up and Running with CerTest: 
 

1. Installing CerTest from the CD 

 

2. Updating to Version 1.03 

 

3. Getting the Latest Test Updates 
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How to Install CerTest 
 
This section provides step-by-step assistance on installing the MS Windows™ version of CerTest 
from the CD. Please read these instructions carefully as you install CerTest. Before you begin, make 
sure that the computer(s) you are going to use for the program meet the minimum requirements listed 
below. 
 
Minimum Computer Requirements:  CerTest (Version 1.03) requires a 486 PC with at least 4 
Megabytes of RAM, DOS 3.3, MS-Windows™ 3.1, a CD-ROM drive, a 3.5-inch floppy drive, and 40 
megabytes of free hard drive space before installation. A stand-alone or network printer access is 
also required to print reports. 

To Install AFIADL CerTest 1.0 from the CD 
 

Step Action 
1 Make sure the computer is on and Windows is running. 
2 Close any open programs.  

To be sure press CTRL+ESC and check the Task List. 
3 Place the CerTest CD in your CD-ROM drive. 
4 Click  the START button in the lower left of the Windows screen and select RUN. 
5 • In the Command Line box enter the letter for your CD drive (probably D) 

followed by a colon, backslash, and SETUP (D:\SETUP).  
• Then click OK to continue.  
• If you are not sure of the drive letter for the CD, use the BROWSE option to 

find the correct drive letter. 
6 A blue INSTALL screen will appear with a box asking for the directory name to 

install the program in. We recommend you use the name AFIADLCerTst.  
 
Your entry in the dialog box should look like this: C:\AFIADLCerTst.  
 
This will ensure the program is installed to the computer's hard drive. If you have 
more than one hard drive, you can select the appropriate drive by replacing the C: 
with the appropriate drive letter (D, E, F, etc.).  

7 The Installation Program copies the appropriate files to your computer. 
8 When prompted, select the Create button to add CerTest icons to the Start menu. 
9 You can add a shortcut to your desktop by placing the mouse on the CerTest icon 

on the start menu, clicking the right mouse button, and selecting CREATE 
SHORTCUT from the drop down menu. If asked about placing the shortcut on 
the desktop, answer yes. Once the shortcut is on the desktop, you can start CerTest 
by double-clicking on the icon. 

 
This completes installation of the basic (1.0) version of AFIADL CerTest and some initial CDC 
end-of-course exams. However, you are not ready to use the program for testing yet!  
 
Proceed to the next step: Upgrading to Version 1.03 
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Upgrading to Version 1.03 
 
Once you have completed installing of CerTest (version1.0) from the CD, your next step is to 
upgrade to Version 1.03. In order to complete this version upgrade you will need to use an Internet 
capable PC to access the AFIADL web site and a formatted high-density (1.44 MB) 3.5-inch floppy 
disk. 

How To Upgrade to Version 1.03 
 
Step Action 
1 Open your Web browser and enter the URL for the AFIADL web site: 

 
http://www.maxwell.af.mil/au/afiadl 

 
If you have the site bookmarked, then select your bookmark. 

2 After the AFIADL home page loads: 
• Close the Hot Topics box 
• Select the Base Ed/Tng tab (upper right corner) 
• Select the CerTest link that you will see under the Testing column 

3 On the CerTest page: 
• Select the CerTest Software Patches link 

4 Insert the formatted 3.5-inch floppy disk into the disk drive (usually A:) 
5 On the CerTest Software Patches page: 

• Click on the CerTest_Update_1_03.exe file name 
6 You should see a window open on your screen: 

• The Window is labeled: Enter Name of File to Save to 
• Check the Save In window and make sure 3.5-inch floppy is showing 
• In File Name box, make sure certest_update_1_03.exe is showing 
• In the Save As Type box, make sure .exe is showing 

7 Click SAVE 
• The certest_update_1_03.exe file is saved to the floppy 

8 Exit your Web browser 
9 From the Windows START menu 

• Select RUN 
• In the RUN dialog window type: A:\certest_update_1_03.exe 
• Or use the BROWSE function and locate the floppy disk and file name 
• Then select RUN 

10 Follow the directions you see on the screen as the program runs 
11 When the program ends, you have successfully upgraded to CerTest Version 1.03 

 
This completes the upgrading to the current version (1.03) of AFIADL CerTest. However, you are 
still not ready to administer tests using the program. 
 
Now, you must download some test updates and install them in the CerTest program. Once you’ve done 
this step, you can start using the program to administer the tests that are available. 
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Adding the Updated Tests 
 
At this point you have successfully installed the CerTest program from the CD and upgraded the 
program to Version 1.03. Just a few more steps and you will be ready to use the program to 
administer the tests that are available. These “last” steps involve getting the most recent test updates 
and installing them in your CerTest program. 

How To Download and Install The Test Updates 
 
Step Action 
1 Open your Web browser and enter the url for the AFIADL web site: 

 
http://www.maxwell.af.mil/au/afiadl 

 
If you have the site bookmarked, then select your bookmark. 

2 After the AFIADL home page loads: 
• Close the Hot Topics box 
• Select the Base Ed/Tng tab (upper right corner) 
• Select the CerTest link that you will see under the Testing column 

3 From the CerTest page, Select the New or Revised Tests Link 
4 On the New or Revised CerTest Exams page: 

• Scroll down the page to the Update 01 download section 
• Have 3 blank 3.5-inch formatted floppy disks ready 

o Label the disks as follows: 
� Update Disk 1 of 3 
� Update Disk 2 of 3 
� Update Disk 3 of 3 

5 Insert the floppy labeled Update Disk 1 of 3 in your floppy disk drive 
6 In the Update 01 section of the New or Revised CerTest Exams page 

• Place the cursor on the xfertest.001 and click the RIGHT mouse button 
• In the dialog box, select Save Link Target As 
• A window will open on your screen: 

o The Window is labeled: Save As 
o Check the Save In window and make sure 3.5-inch floppy is showing 
o In File Name box, make sure xfertest.001 is showing 
o In the Save As Type box, make sure Text file is showing 
o Then Click Save 

• The dialog box will remain showing while the file is copied 
• When the copying is completed, remove the disk 

7 Repeat the steps in Step 6 for the remaining two files: 
• xfertest.002 
• xfertest.003 
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Step Action 
8 When you have copied all 3 update files: 

• Start CerTest and log on as manager 
• Select the FILE menu; then select Open Test List 
• Insert Update Disk 1 of 3 into the disk drive 
• From the CerTest FILE menu select Copy from Diskette 
• In the dialog box, select the xfertest.001 file 
• Click OK 

If you see a Replace Tests dialog box that asks Do you want to replace tests? 
• Select the Yes if Newer response 

When copying is completed, repeat these steps for the other 2 update disks 
9 When all tests have been copied, you have completed the upgrade to version 1.03 

 
Now that you have your CerTest program upgraded to version 1.03, you need to install some 
updated tests. Once you’ve installed these test updates you’ll be ready to test students using your 
CerTest program. 
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How to Download and Install Test Updates 2 through 4 
 
Step Action 
1 Open your Web browser and enter the url for the AFIADL web site: 

 
http://www.maxwell.af.mil/au/afiadl 

 
If you have the site bookmarked, then select your bookmark. 

2 After the AFIADL home page loads: 
• Close the Hot Topics box 
• Select the Base Ed/Tng tab (upper right corner) 
• Select the CerTest link that you will see under the Testing column 

3 Insert a blank, formatted floppy disk into the floppy drive 
4 From the CerTest page, Select the New or Revised Tests Link 
5 Copy Update 02 to the floppy disk 

 
Note: You may substitute a folder on the hard drive for this process. We recommend you name the 
folder TestUpdates. Be sure to substitute the folder name for the floppy drive designator in the 
remaining steps of the process. Don’t forget to change the Save In window to the correct drive and 
folder name. 

 
From the New or Revised CerTest Tests page 

• Place the cursor on the test9009.tst file and right click the mouse 
• In the dialog box select Save Link Target As 
• A window will open on your screen: 

o The Window is labeled: Save As 
o Check the Save In window and make sure 3.5-inch floppy is showing 
o In File Name box, make sure test9009.tst is showing 
o In the Save As Type box, make sure Text file is showing 
o Then Click Save 

 
When the Copying dialog box closes:  

• Return to the New or Revised CerTest Tests page 
• Place the cursor on the test9009.txt file and right click the mouse 
• In the dialog box select Save Link Target As 
• A window will open on your screen: 

o The Window is labeled: Save As 
o Check the Save In window and make sure 3.5-inch floppy is showing 
o In File Name box, make sure test9009.tst is showing 
o In the Save As Type box, make sure Text file is showing 
o Then Click Save 

 
When the Save dialog box closes: 

• Repeat these instructions for the test9018.tst and test9018.txt files 
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Step Action 
6 Copy Update 03 to the floppy (use the same or a new floppy) 

 
Note: You may substitute a folder on the hard drive for this process. We recommend you name the 
folder TestUpdates. Be sure to substitute the folder name for the floppy drive designator in the 
remaining steps of the process. Don’t forget to change the Save In window to the correct drive and 
folder name. 

 
From the CerTest page, Select the New or Revised Tests Link 
 
From the New or Revised CerTest Tests page 

• Place the cursor on the jan03set.tst file and right click the mouse 
• In the dialog box select Save Link Target As 
• A window will open on your screen: 

o The Window is labeled: Save As 
o Check the Save In window and make sure 3.5-inch floppy is showing 
o In File Name box, make sure jan03set.tst is showing 
o In the Save As Type box, make sure Text file is showing 
o Then Click Save 

 
When the Copying dialog box closes:  

• Return to the New or Revised CerTest Tests page 
• Place the cursor on the jan03set.txt file and right click the mouse 
• In the dialog box select Save Link Target As 
• A window will open on your screen: 

o The Window is labeled: Save As 
o Check the Save In window and make sure 3.5-inch floppy is showing 
o In File Name box, make sure jan03set.tst is showing 
o In the Save As Type box, make sure Text file is showing 
o Then Click Save 

7 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copy Update 04 to the floppy (use the same or a new floppy) 
 

Note: You may substitute a folder on the hard drive for this process. We recommend you name the 
folder TestUpdates. Be sure to substitute the folder name for the floppy drive designator in the 
remaining steps of the process. Don’t forget to change the Save In window to the correct drive and 
folder name. 

 
From the CerTest page, Select the New or Revised Tests Link 
 
From the New or Revised CerTest Tests page 

• Place the cursor on the revcrs12.tst file and right click the mouse 
• In the dialog box select Save Link Target As 
• A window will open on your screen: 

o The Window is labeled: Save As 
o Check the Save In window and make sure 3.5-inch floppy is showing 
o In File Name box, make sure revcrs12.tst is showing 
o In the Save As Type box, make sure Text file is showing 
o Then Click Save 
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7 

cont’d 

When the Copying dialog box closes:  
• Return to the New or Revised CerTest Tests page 
• Place the cursor on the revcrs12.txt file and right click the mouse 
• In the dialog box select Save Link Target As 
• A window will open on your screen: 

o The Window is labeled: Save As 
o Check the Save In window and make sure 3.5-inch floppy is showing 
o In File Name box, make sure revcrs12.tst is showing 
o In the Save As Type box, make sure Text file is showing 
o Then Click Save 

 
This completes copying the updates from the AFIADL site. Your next step is to install the 
updates in your copy of the CerTest program. 

8 To install the update to the CerTest program: 
 
Start CerTest and log on as manager 

• Select the File menu; then select Open Test List 
• Insert your Test Update Disk into the disk drive 
• From the CerTest File menu select Copy from Diskette 
• In the dialog box, highlight the file name you want to copy (revcrs12.tst) 
• Click OK 

 
A Copy Test(s) Into CerTest dialog box opens 

• Select the test to be copied by clicking on the name 
• If you want all tests, select the names for all tests 
• Click Copy 
• If you see a Replace Tests dialog box that asks Do you want to replace tests? 

o Select the Yes if Newer response 
 
The copy process executes. You will see a dialog box showing the number of tests copied 
when copy process ends. 
 
Repeat these steps until you have copied each of the test update files that you have on floppy 
or in your TestUpdates folder. 

 
 
Now you are ready to use CerTest to administer tests available through the program. 
 
However, before you can administer tests, you need to complete the program set up process. 
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Setting Up CerTest for Administering Tests: 
 

1. Initial CerTest Start Up 

 

2. Adding Yourself (and Others) as Test Administrator(s) 

 

3. Deleting the Generic Log-in (Sir Test) 
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Initial CerTest Start Up 

 
Before you can use CerTest to administer tests, you have to complete some administrative tasks 
so that the program has information to identify your Test Control Facility. 
 
When you reach the initial log-on screen, the program requests that you enter a Social Security 
Number and a password. Entering your Social Security Number and a password at this step will 
result in an error because your information is not available in the program. 
 
CerTest has a default “generic” Social Security Number and password that everyone uses the 
first time they access the program. These are: 
 

Social Security Number: 123-45-6789 
Password: AFIADL 

 
You will need these in order to complete the set up process. 
 

Step Action 
1 Start CerTest by clicking on the desktop icon or selecting CerTest from the Start menu. 
2 • When the CerTest main screen opens, click anywhere in the blue area to start the 

program. 
• Upon clicking in the blue area you see the log-on box requesting the Social Security 

Number and Password. 
3 Entering the following Social Security Number and password will log you onto CerTest 

as Sir Test, the default manager.  
    Social Security Number: 123-45-6789 

Password: AFIADL 
4 Once you’ve entered the program, you need to provide some Site Information that the 

program uses when you send data to AFIADL. 
 
The next step is to enter your Test Control Facility (TCF) information (See the sample 
shown below). This information is critical for identifying the data files that you will send 
to AFIADL after each test session. Therefore, the first time you log on after installing 
CerTest, you will be prompted to enter this information.  
 
You will not be able to use CerTest without entering this information.  

 
Once you have entered the TCF data, you will not need to enter it again. However, if your TCF 
information changes, you may edit the TCF data. 

 
Note:  If a TCF data field does not apply to your base, leave the field blank. However, you 
MUST fill in the TCF Zip, TCF Shred and Base fields in order to continue. If you are using 
CerTest on more than one stand-alone computer, assign each computer a different number 
and enter that number in the Computer Number field. This is not necessary if you are 
running CerTest on a Local Area Network. 
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Subject Sample Information 

Enter Your TCF Zip: 32403 
Enter Your TCF Shred: 01 
Enter a Number Identifying the Computer: 01 
Enter Your DSN #: 596-4331 
Enter Your Commercial Phone #: (334) 416-4331 

Enter Your E-mail Address: John.Doe@maxwell.af.mil 

Enter Your Organization: HQ AFCESA 

Enter Your Base Name: Tyndall AFB 
Enter the 2 Letter Abbreviation for Your 
State: 

FL 
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Adding Yourself (and others) as Test Manager(s) 
 
After you have opened the program, logged in as the generic manager in the previous step, and 
entered your TCF information in the appropriate blocks, you are ready to add test managers to the 
program. 
 
It is important that you add test managers now because you must remove the “generic” manager 
Social Security Number and password as part of the activation process. If you do not add at least 
one manager now, you will not be able to access the program once you take the next step and delete 
the “Sir Test” generic log in and password. 
 
If you are going to be the primary test manager, add yourself to the manager list first. Then add any 
other individual test control office personnel who are qualified to administer tests before exiting the 
program. 

Add a Test Manager 
 
Step Action 
1 From the File menu: 

• Select Open Manager List. 
2 From the File menu: 

• Select Edit or click on the + icon. 
3 Select Add Manager.  

Test Control Facilities are allowed to have as many managers as they need to effectively execute their 
CerTest responsibilities. 

4 On the New Manager Information screen:  
• Enter appropriate information in these areas: 

o Manager’s Last Name 
o Manager's First Name 
o Manager's Social Security Number (SSAN) 
o Rank and Middle Initial. 

5 Select a Password. 
• Do not use any password you use for other computers you have access to 

6 In the Change Manager’s Password dialog box: 
• Enter your New Password. 
• Verify your Password by repeating the entry from the New Password box. 
• Select OK. 

7 Select Privileges. 
A manager has three privilege types: Test, File, and Personnel. Each has a list of responsibilities that may 
be assigned by using the check box next to it. If the box is not checked, checking it adds that privilege; 
removing the check removes that privilege. 

8 To change the default selections for a privilege, click on the desired option’s check box. 
9 When the screen reflects the desired privileges, select OK. 
10 Select OK on the New Manager Information screen. You’ll see a confirm message. 
11 Select OK in the system message box. 
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Deleting the Generic Log In (Sir Test) 
 

Warning:  For system security, the Sir Test manager (the generic log in for initial program 
use) must be deleted from your system. 

 
Step Action 
1 Log into CerTest as Sir Test. 

• Start CerTest 
• At the Log On prompt 

oEnter 123-456-789 for Social Security Number 
oEnter AFIADL for Password 

• Click OK 
• At the “Welcome. . .your last log in was. . .” box, Click OK 

2 Check to make sure that you have been added as a manager. 
• Click on File in the toolbar. 
• Select Open Manager List from the drop down menu 
• Look at the listed managers for your name. 

If your name is not in the list, complete the steps in the preceding Add a Test 
Manager section. 

If your name is in the Test Manager list, proceed to Step 3. 
3 Click on File in the toolbar. 

Select Go To Logon Screen from the drop down menu 
• At the Log On prompt 

oEnter your Social Security Number  
oEnter your Password 

• Click OK 
At the “Welcome. . .your last log in was. . .” box, Click OK 

4 Click on File in the toolbar. 
• Select Open Manager List from the drop down menu 

5 Delete the Sir Test manager. 
• Select Sir Test in the manager list by clicking on the name  
• Select Edit in the toolbar 
• Select Delete Manager from the drop down menu 

oWhen the Delete Manager(s)? box opens displaying Sir Test manager name 
o Select Yes to Delete Manager 

6 After you click Yes to Delete Manager: 
• Sir Test is deleted as manager 
• The Manager List is displayed 

 
Congratulations, you have successfully deleted the Sir Test manager. The generic log on is no 
longer possible. From this point on, only those individuals in the Manager List will be able to 
use the program from the log on screen. 
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How to Delete a Manager 

The Delete Manager function removes a manager from the CerTest system. 

 
Step Action 
1 Open the Manager List. 
2 Highlight the manager's name for deletion. 
3 Select Edit (menu bar) or click on the scissors icon. 
4 Select Delete Manager. 
5 Select Yes in the Delete Manager(s) confirmation box. 

 

Shortcut keys: 

SHIFT + DELETE will replace steps 3 and 4. 

 
Note:  You may not edit or delete a manager with privileges that you do not have. 

 
 
Now you are ready to administer a test for a student.  
 
To administer tests, see the following section:  Student Testing Sessions 
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Student Testing Sessions: 
 

1. Adding a Student to the Student List 

 

2. Unlocking Tests for Students 

 

3. Completing the Session: Recording Results 
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Student Testing Sessions 
 

Student Testing! Here is the heart of the CerTest program: providing the test and a score for 
enrolled students. You’ve always provided this service; now you’re doing it with a twist. You’re 
providing a computer-based test rather than a paper one and you’re providing immediate 
feedback on performance instead of having the student wait for a postcard from AFIADL. And, 
just like you’ve always done, there are some administrative tasks associated with the student 
testing session. 
 
Working with CerTest you will be responsible for: 

• Entering Student Information in the program 
• Providing Assistance if requested (the Student Guide and CerTest tutorials should 

suffice) 
• Unlocking Tests for the Students 
• Initiating the Scoring Process 
• Printing a Student Report 
• Sending Student Data to AFIADL 

 
So, let’s get started with the first step: Entering Students in the program. 
 

 
Adding A Student To The Student List 

 
Before you allow a student to take a test in CerTest, the student’s information must be entered 
into the program. Entering student data is a process similar to that of adding managers to the 
program. 
 
You may enter students before their testing sessions if you have their information. You may 
enter students at the start of the testing session. When you do this is your decision. Just 
remember that student data must be in CerTest before you can unlock a test and before the 
student can log on to take a test. 
 

How to Add a Student 

The Add Student function enrolls a new student for taking tests in the CerTest system. 

 
Step Action 
1 Start CerTest and log on as Manager. 

• CerTest should open showing the Student List. 
2 If the Student List is not showing: 

• Select File from the toolbar 
• Select Open Student List from the drop down menu 
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Step Action 
3 When the Student List is showing on the screen 

• Select Edit 
• Select Add Student from the drop down menu 
• The New Student Information box opens 

4 Enter the appropriate data in the New Student Information screen: 
• Last Name 
• First Name 
• Middle Initial 
• Student's Social Security Number (SSAN) 

 
Use the drop down menu to select the appropriate entry for: 

• Service 
• Rank 

 
Under Specialties: 

• Final Exam is the default entry 
oLeave it checked 

• You may double-click on Demonstration Test if the student is new to the 
program 

 
Click on Password 

• The Change Student Password box opens 
• Enter a password in the Password box 

oThere are no specific rules for the password 
oYou assign the password for initial program log on by the student 
oThe student may change the password once log on is completed 

• Re-enter the password in the Verify Password box 
• Click OK 

 
You return to the New Student Information screen 

• The OK box is now active 
oReview the student information for accuracy 
oClick OK 

• A System Message displays stating that the student has been added 
• Select OK in the System Message box 

 
You return to the Student List 
  
This message is shown on the screen: 
 

To unlock tests for this student you must go to his/her student 
record. Would you like to go to this student’s record now? 
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Step Action 
4 

cont’d
• Selecting Yes takes you directly to the student’s record to unlock the applicable 

test.  
• Selecting No allows you to add additional students or exit the program. 

If you select No, see the instructions on How to Lock and Unlock Tests 
5 To add more students: 

• Repeat Steps 3 and 4 

 
Once you have finished adding a student or list of students, you can administer tests. In order to 
administer a test to a student after adding a student to the student list, you must access that 
student’s record and unlock the test. 

For instructions on unlocking a test see: How To Unlock a Test 
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How to Unlock a Test 
 
Locking and unlocking a test allows the manager to open a test for a student to take or close a test to 
prevent a student from taking or viewing it. If a test is locked, a key is displayed to the left of that 
test's name on the Student Record screen. 
 

Step Action 
1 Start CerTest and log in as manager if the program is not open. 
2 Open the Student List. 

 
If the Student List is not showing: 

• Select File from the toolbar 
• Select Open Student List from the drop down menu 

3 Highlight the name of the student whose record you want to view. 
 
You can select the name by: 

• Clicking on the Name with the left mouse button 
• Placing the cursor next to the name and holding down the left 

mouse button and moving the cursor across the name 
4 From the Menu bar: 

• Select View  
5 From the View drop down menu: 

• Select Student Record. 
6 The Student Record screen: 

• Shows the Student Name 
• Complete List of Available Tests 

7 To Unlock a Specific Test: 
• Use the mouse to move the scroll bar on the right of the screen 
• Scroll down until the desired test is showing in the window 
• Click on the Key block to highlight the test 
• Click on the Key Icon on the Menu Bar to Unlock the Test 

 
 
You have now unlocked a test for the student. 
 
In order for the student to take the test,  

• Select File from the Menu Bar 
• From the Drop Down Menu: Select Go To Log On Screen 

 
Helpful Hints: 
� You can double-click on the lock column next to a test to toggle the lock status. 
� You can use the L and U keys to Lock or Unlock tests instead of the key icon in the tool bar. 
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Additional Information: 
 
You can lock and unlock more than one test by: 
 

1. Pressing the CTRL key while clicking on a test. This makes an additional selection without 
deleting any previous selection(s). 

 
2. Pressing the SHIFT key while clicking on another test will select that test and all the tests 

between an earlier selection and your current selection. 

To exit the Student Record screen: 

Press CTRL + S. 
 
 
 
Once you have unlocked the appropriate test and returned to the Log On screen, its time for the 
Student to take the test. 
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Student’s Testing Session 
 
Now that you have added the Student to the program, unlocked the test, and returned to the Log 
On screen, you’re ready for the student to use the program. 
 
First: 

• Have the Student Log On by: 
o Entering his/her Social Security Number 
o Entering the Password you assigned the student 

 
 
Second: 

• CerTest opens to the Student Record screen and shows the test list 
• Have the Student scroll down until the unlocked test appears in the list 
• Have the Student Select the Test by double-clicking on it with the mouse 

 
 
Third: 
When the student selects the test by double-clicking with the mouse: 

• The Test Spec(s) Screen Opens 
• Have the Student read the information on the screen 
• Then have the Student select the Take Test button 

 
 
Fourth: 
After the Student selects the Take Test button: 

• A Generating Test screen appears, followed by the first question in the test 
• Follow your Test Proctor guidelines while the student is taking the test 
• The Student can freely navigate forwards and backwards through the test 
• The Student may challenge a question following the Challenge procedure in the Student 

Handook 
• Note: AFIADL/ECI Form 17 cannot be used to Challenge CerTest Questions 
• The Student may freely use the Help menu 

 
 
The following pages show examples of: 

• A Question Screen 
• The Challenge Process (in case you need to assist the student) 
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Sample CerTest Question 
 
This is a sample CerTest question. We have highlighted several of the features that are of interest to 
students taking the tests. TCOs should become familiar with these features. 
 

 
 

Bookmark Feature:  When taking a test, a student may choose to mark a question and return to it 
later before the test is exited and scored. 
 
Moving Within a Test Using the Scroll Bar:  The scroll bar located in the bottom right-hand 
corner of the screen is active during a test session. This feature allows the student to move forward 
or backward one or more questions at a time. For example, let’s say you just completed a 60-
question test but you would like to review questions 5, 12, 39, and 52 before you exit and score the 
test. In this instance, you could quickly review these questions by using the scroll bar. 
 
Challenging a Question:  While taking a test, a student may find a question that he/she believes to 
be erroneous or invalid for some reason. The student may challenge the question by clicking on the 
hand icon located in the top right-hand corner of the toolbar, or by selecting “Challenge this 
Question” from the Help menu. 
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Test Question Challenges 
 
While taking a test, a student may find a question that he/she believes to be erroneous or invalid for 
some reason (i.e., typo, spelling mistake, missing graphic, ambiguous question, etc.). The student 
may challenge the question by clicking on the hand icon found on the top right hand corner of the 
toolbar, or by selecting Challenge This Question from the Help menu. This allows the student to 
type a short description of the error. All question challenges are automatically downloaded when you 
collect and electronically transmit the required student data files to AFIADL. 
 
 

 
 

NOTE: AFIADL/ECI Form 17 cannot be used to Challenge CerTest Questions 
 
On the other hand, on rare occasions you may be asked to view, print, re-download, or delete the 
question challenges.  
 
The instructions for these procedures are found in the Appendix at the end of this Guide. 
 
 
The next part of the process is Scoring The Test. 
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Scoring The Test 
 
When the student has progressed through the test and answered the final question, the program 
presents a choice: Exit and Score the Test or Review Unanswered Questions. 
 

Warning:  If the student chooses to exit the test without reviewing Unanswered Questions, any unanswered 
questions will be scored as wrong. 

 
If the student elects to return to the Unanswered Questions, the program presents the unanswered 
questions and gives the student a final chance to answer them. Once all unanswered questions have 
been presented, the student is presented with the Exit and Score the Test box. 
 

NOTE:  If a student selects to Exit and Score a Test and has left any Unanswered or bookmarked questions, 
CerTest asks if the student wants to return to the unanswered or bookmarked questions. 

 
Once a student has answered all of the questions in a test and chooses to exit and score the test, the 
following message is shown.  
 

To score this test, the test control officer must input their password. If you are ready to exit and score 
your test, call the test control officer over to your computer now. Press Cancel to continue reviewing 
your test. 

 
You (the test control officer) must enter the test validation code in order to score the test. If the 
validation code is not entered correctly, the test cannot be scored. This feature prevents a student 
from scoring his/her test without the test control officer being present.  
 
The test validation code is the your CerTest log-in password. 
 
There are three Test Scoring Methods: 
 
Method 1: 
 

Step Action 
1 The student selects Score in the tool bar of the last test question. 
2 The student selects Yes in Exit and Score box 

• Selecting No cancels Exit and Score 
3 When the Test Control Officer Validation Code box appears: 

• The student calls the Test Control Officer over to score the test 
4 You enter your Validation Code, then  

• The test is scored. 
• The Test Summary Screen is shown (a sample is shown after Method 3). 

5 While the Test Summary screen is showing, the student may: 
� View the results 

o Select Cancel when done  
� Select History to see his/her previous scores for this test (if any). 

o Select OK. 
o Select Cancel. 
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Method 2 
 

Step Action 
1 After the last test question: 

� The student presses the Enter key 
2 The student selects Yes in Exit and Score box 

� Selecting No cancels Exit and Score 
3 When the Test Control Officer Validation Code box appears: 

• The student calls the Test Control Officer over to score the test 
4 You enter your Validation Code, then  

• The test is scored. 
• The Test Summary Screen is shown (a sample is shown after Method 3). 

5 While the Test Summary screen is showing, the student may: 
� View the results 

o Select Cancel when done  
� Select History to see his/her previous scores for this test (if any). 

o Select OK. 
o Select Cancel. 

 
NOTE:  
Methods 1 and 2 can be used only immediately after answering the last question in a 
test. Method 3 can be selected from any question in the test.  

 
 
Method 3 
 

Step Action 
1 The student selects File from the menu bar. 
2 The student selects Exit and Score. 
3 The student selects Yes in the Exit and Score box. 
3 When the Test Control Officer Validation Code box appears: 

• The student calls the Test Control Officer over to score the test 
4 You enter your Validation Code, then  

• The test is scored. 
• The Test Summary Screen is shown (a sample is shown after Method 3). 

5 While the Test Summary screen is showing, the student may: 
� View the results 

o Select Cancel when done  
� Select History to see his/her previous scores for this test (if any). 

o Select OK. 
o Select Cancel. 

 
Shortcut Keys:  ALT + F4 will also indicate that the student wants to Exit and Score the test. 
 
A sample Test Summary Page is shown below. 
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Test Summary Information 

 
To maintain test security, CerTest does not provide specific test question feedback. However, just like existing CDC 
exams, CerTest does indicate the Learning Objective(s) (LO) that require further study. The following “Test 
Summary” information is designed to help students pinpoint the areas that require further study. 
 
Here's how you would use the following printout:  The questions column tells the student how many questions 
appeared on the test and the correct column tells the student how many questions were answered correctly in each 
particular section. 
 

Carruthers, Joe      000-00-0000 
9020 – Hazardous Materials Awareness 

Test Date: 28 Jan 00 
Score:  91% 
Criterion: 65% 
 
 REVIEW TRAINING        STARTED __________   DUE COMPLETION __________   COMPLETED __________ 
 REQUIRED ____ 
 NOT REQUIRED ____     __________________________________     _____________________________________ 
                                                  SUPERVISOR’S SIGNATURE                             TRAINEE’S SIGNATURE 
 
Section       Title          Questions    Correct 
      1   LO 001 General        2        2 
      2   LO 002 Definitions of Hazardous Materials        3        2 
      3   LO 003 Classes & Divisions        25        20 
      4   LO 004 HazMat vs. Other Emergencies        1        1 
      5   LO 005 Occupancies & Locations        2        2 
      6   LO 006 Container Shapes        3        3 
      7   LO 007 Marking & Colors        3        3 
      8    LO 008 NFPA 704        2        2 
      9   LO 009 Where to Find MSDSs        1        1 
    10   LO 010 MSDS & Shipping Paper Entries        5        5 
    11   LO 011 Shipping Papers        2        2 
    12    LO 012 Locations of Shipping Papers        3        3 
    13   LO 013 Examples of Clues        2        2 
    14   LO 014 Limitations of Using Senses        2        2 
    15   LO 015 Criminal or Terrorist Targets        1        1 
    16   LO 016 Indicators of Criminal/Terrorist Activity        1        1 
    17   LO 017 Difficulties Determining Names        2        2 
    18   LO 018 Sources for Obtaining Names in Transport        2        2 
    19   LO 019 Sources for Obtaining Names in Facilities        1        1 
    20   LO 024 Basic Precautions        2        2 
    21   LO 025 Emergency Medical Care        1        1 
    22   LO 026 Typical Ignition Sources        1        1 
    23   LO 027 Harmful Effects of Hazardous Materials        1        1 
    24   LO 028 Routes of Entry        2        2 

             Totals: 70        64 
 
To complete the Scoring Process, Print a Copy of the Test Summary Page for the student. 
 
 

Sample Test Summary 
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To Print a Copy of the Test Summary Page: 
 
With the Student’s Test Summary Page showing:  
� Click on the PRINTER icon on the menu bar 
� Give the Student the printed copy 

 
 
This step completes the Student Testing phase of the test session. 
 
The next tasks required to complete the process are: 
 
� Collecting Student Data for Sending to AFIADL 

 
� Sending Student Data to AFIADL 
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Retests for Students Failing an Exam 

 
AFIADL policy provides for one retake for a failed exam (for a total of two test attempts) before a 
course failure is reported in student records. If a student takes and fails an exam, the score must be 
reported to AFIADL using established procedures and the student is entitled to take the exam a 
second time. However, there are certain guidelines that must be followed for retakes: 
 

• A student retaking a CerTest exam must retake the exam on the same computer on 
which the first exam was given. This is because the student’s record of the exam and the 
test items presented are stored on that computer. (This does not apply in situations where 
CerTest is networked and running off a server; in this set up, the student records are 
maintained on the server). 

 
• For CDC exams, retakes must be accomplished within 30 days of the initial test. 

 
• For Course 12, a 30-day remediation period must elapse before a retake is authorized. This means that 

the earliest date a retake for a Course 12 exam is on the 31st day following the day on which 
the initial test was given. 

 
 
To administer a retake in CerTest: 
 

1. Ensure that the student is assigned to the same testing computer used in the previous test 
session. You can do this by simply logging into the computer, starting CerTest, opening the 
Student List and making sure the student is in the list for that stand-alone PC. Do NOT add 
the student; log out and check the other stand-alone PCs until you find which PC the 
student used. (Obviously it’s a good idea for you to put numbers on each of your stand-
alone PCs and have the student note the PC he/she used in the event a retake is required.) 

 
2. Once you have located the correct PC for the student’s retake, follow the instructions for 

Unlocking a Test on page 25 of this TCO Guide. 
 
Note: You will unlock the same test number for the student. This gives the appearance of 
giving the same exam as previously given. This is not the case. The CerTest exams are 
“generated” from a bank of questions. During a retake, the program reviews the student 
record (which is why it is important to use the same computer from the first test session for 
that student) to determine which questions from the bank were presented. The program 
then selects different items to present for the retest. However, the student may see some 
questions from the first test if the items are required to be presented for all tests. If an item 
is repeated, its options are randomized and not presented in the same sequence they were 
on the student’s first exam. 
 

3. All other procedures for a student testing session and scoring are the same as if this were an 
initial test.  
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Managing Student Data 
 
 

1. Downloading Student Data to Floppy Disk 

 

2. Installing the Answer Sheet Manager Program 

 

3. Using the Answer Sheet Manager Program 

 

4. Installing the FTP Software 

 

5. Sending Files to AFIADL 
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How to Download Student Data to a Floppy Disk 

 
Each time a student takes a test, CerTest automatically stores data about that test session in its 
database. This data must then be downloaded from CerTest and sent to AFIADL. To do this, you 
must use the Download ECI Data feature.  
 

Note:  If you have more than one student taking a test at your base on a given day, we suggest 
you wait until the end of the day to download the AFIADL data for all of the students that 
tested that day. 

 
When you select the Download ECI Data feature, CerTest creates two types of data files:  
 

File Type Description 
.ECI 
extension 

When you download AFIADL data for one or more test sessions, data for all of 
the selected test sessions will be downloaded to a single .ECI file.  
 
Each .ECI file is assigned a unique file name based on the date and time (for 
example, 284B5CE8.ECI). 

.00A or .00B 
extension 

When you download ECI data for one or more test sessions, a .00A or .00B file 
will be downloaded for each of the selected test sessions.  
 
These files are assigned unique file names based on the date and time of their 
associated test session (for example, 278D7D21.00A). 

 
 
These data files contain the following data: 

• Student’s test results 
• Each student’s electronic answer sheet 
• Cumulative statistical data about the tests taken 
• Any Question Challenges  

 
At the end of each testing day, you must send the applicable test data to AFIADL using the 
following procedures:  
 
� Downloading the test results from the computers 
� FTP the results to AFIADL. 
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FIRST: Download Test Results to Floppy Disk 
 

Download Test Results for Dispatch to AFIADL 
Step Action 
1 Insert a blank, formatted 3.5-inch disk into the disk drive 
2 Start CerTest and log on as manager 
3 Select File from the Menu bar 

� From the Drop down menu Select Download ECI Data 

NOTE:  All of the CerTest data can be downloaded to the same diskette. 

4 The Download ECI Data box is shown. 
� All the test sessions that have not yet been downloaded are listed. 

3 Select the test session(s) (by student, test and date) that you wish to download. 
� Select the Download button.  
� Always select all of the records shown. 

4 Select the drive (usually a: ) and directory (if applicable) you wish to download to.  
 
When the test session(s) download is complete,  
� A message box tells you how many sessions were downloaded.  

 
Use this floppy disk for sending data to AFIADL. 

 
 

NOTE: Once you have downloaded the ECI data for a test session, the session no 
longer appears in the list of test sessions in the Download ECI Data window.  

 
 
After copying the files to a floppy, you need to use the Answer Sheet Manager to prepare a batch file 
for sending data to AFIADL. 
 
Before you can prepare the batch file, be sure that the Answer Sheet Manager is installed on one of 
your computers. 
 
Answer Sheet Manager should be installed on a computer with internet access to facilitate data 
transmission. 
 
 
Detailed procedures for the Answer Sheet Manager and FTP process are available on the AFIDAL 
Web Site: 
 
 http://www.maxwell.af.mil/au/afiadl/operation/xferguid_fr.htm 
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How to Install the AFIADL Answer Sheet Manager Software 
 

Step Action 
1 Create a temporary directory on your computer's C:\ drive (e.g., C:\TEMPECI). 
2 Copy the file ECIZIP.EXE from the ECI directory on the CD-ROM into this 

temporary directory. 
3 Open the temporary directory so you can see the ECIZIP.EXE file. 
4 Using your mouse, double-click on this file.  

� The file expands and creates additional files.  
� Close the window when the unzip ends. 

5 Look for SETUP.EXE  
� Use your mouse and double-click on it. 

6 The program asks if it is OK to install the ASM into the C:\ECI directory.  
� If you are upgrading and have already installed the ASM into the ECI directory, 

or 
� This is your first installation and there is no ECI directory,  

o Click the Continue button.  
 
If an ECI directory already exists and the ASM has not been installed here,  
� Change the Directory to something else (e.g., C:\ECI2) and  
� Click the Continue button.  

 
Remember the installation directory in case you need help. 

7 For those using Windows 95: 
� Refer to Windows Help to create a shortcut for the MERGFILE.EXE.  
� This will make it easier to run the program.  

 
If you are using Windows 3.x, or higher: 
� A program group is automatically created called Answer Sheet Manager.  
� MERGFILE and the Answer Sheet Manager are one and the same.  

 
In Windows 95, all shortcuts are titled according to their filenames. In Windows 3.x, 
ASM's real name: Answer Sheet Manager is shown. There is no difference. 

8 Double-click on the  
� MERGEFILE shortcut in Windows 95  
� or Answer Sheet Manager icon. 

9 A TCF Data screen is displayed. Fill in all the information you know.  
• As a minimum, fill in the tcf zip and shred number.  
• Type the zip code without a "-" and without the shred number.  
• Notice that the shred number has its own entry field. 

10 When this is complete, click the OK button. 
11 The ASM prompts you for a disk.  

• If you are installing and do NOT have any student disks to scan, simply insert 
any formatted disk and click OK.  

• Otherwise, see Using Answer Sheet Manager on how to use the program. 
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If you do not have the original distribution disk, you can download Answer Sheet Manager from the 
AFIADL web site (http://www.maxwell.af.mil/au/afiadl). 

� Select Base Ed/Tng Tab 
� Select Testing 
� Select CerTest 
� Select Windows NT Answer Sheet Manager 

� Note: This is for both Win NT and Win 2000 
� Copy the File 
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Using the Answer Sheet Manager Program 
 
If you have not installed the Answer Sheet Manager Program, refer to Setting Up Answer Sheet 
Manager on the previous page. 
 
You need two diskettes to save your batch files and backup files:  
� Label one batch 
� Label the other backup 

 
 

Step Action 
1 Double-click  

� The MERGEFILE shortcut in Windows 95 or  
� The Answer Sheet Manager icon. 

2 Insert the first student test disk. 
3 Click on the Scan Disk for Answer Sheet Files button.  

� You should see at least one answer sheet file displayed in the New Files area.  
� If not, please call or E-mail us for assistance. 

4 Click on the Add Answer Sheet Files to Batch button.  
� The file(s) should move to the Batch area.  

 
If you have other student test diskettes to batch,  
� Remove the first student test diskettes 
� Insert the next diskette.  
� Click on Add Answer Sheet Files to Batch button.  
� The file(s) should move to the batch area. 

5 Select Save from the menu.  
� You will be prompted for another disk. 

6 � Insert the batch disk 
� Click on the OK button.  

 
When the save is complete, you will return to the ASM. 

7 Select Exit from the menu.  
� When prompted to perform a backup, click the OK button.  
� You will again be prompted for another disk. 

8 � Insert the backup disk  
� Press the OK button.  

o When finished, ASM closes and your computer returns Windows.  
� Remove the backup disk. 

9 Please refer to Help in the menu selection for assistance if you have questions. 
 
 
Your next step in sending data to AFIADL is to transfer the batch files. Before we get to those 
instructions, here is some additional information that you need to know. 
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Optional, To Download a Test Session a Second/Subsequent Time 
 

Downloading Test Session a Second/Subsequent Time 
Step Action 
1 Take the data diskette to the computer where the Answer Sheet Manager and File 

Transfer Program (FTP) software are installed.  
(We recommend you install these software programs on the same computer.) 

2 � Insert the diskette  
� Run the Answer Sheet Manager Program. 

3 Select Scan for answer sheet files. 
4 Select Add answer sheet files to batch. 
5 Select Save. 
6 Insert a blank diskette and select OK. 

 
The Answer Sheet Manager lists the files copied to the diskette. These are: 
� One batch file with a name like ZZZZZS.NNN where ZZZZZ is the 5 digit 

zip code of your base, S is your base test control office Shred number, and 
the NNN is a number from 001 to 999. 

� One or more .ECI files (one file for each computer from which CerTest data 
was downloaded). 

7 Exit the Answer Sheet Manager program. 
 
Do NOT transfer the raw answer sheets.  

� They are easily identified by their filenames, which begin with the letter v.  

� The next 7 digits in the filename are the first 7 numbers of the student's Social 
Security Number (SSN).  

� The file extension will correspond with the student's course number and will be 00A, 
00B, 00C, 00D, or 00E.  

Please, transfer only batch files.  

The easiest way to avoid confusion is to 

� Insert the batch disk after removing the backup disk.  

� Put all other disks away. 

 
 
In order to send the batch files you must use a file transfer protocol (FTP) program. You should 
install the FTP program before attempting to send batch files.  
 
The following pages provide instructions on: 
� Installing the FTP Program 
� Using the FTP Program to Send Data to AFIADL 
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How to Install the FTP Software 

 

The file transfer protocol program for sending data to AFIAL is called WS_FTP Pro. It is a 
Windows-based application for transferring files between your PC (the local system) and a 
remote system (AFIADL). WS_FTP Pro allows you to connect to another system from your 
PC, browse directories and files on both systems, and transfer files between the systems. 

WS_FTP Pro is easily used by a beginner and includes a full set of functions for the power 
user. See WS_FTP features for a list of some of the available features. 

For Your Computer Folks: WS_FTP Pro is a File Transfer Protocol (FTP) client application 
that complies with the Windows sockets (Winsock) standard. WS_FTP Pro can connect to 
any system that has a valid Internet Address and contains an FTP server program, allowing 
you to transfer files between a wide variety of systems, including Windows, OS\2, and UNIX 
systems. 

The WS_FTP program is included on the CerTest distribution CD that you received. 

To install the FTP software: 

� Click on START 

� Select RUN 

� Select BROWSE 

� Locate the directory for Ws_ftp95 

� Then Select Install.exe 

� Click OK 

� Follow the prompts on the computer screen. 

If you experience problems installing this software detailed procedures are available on the 
AFIDAL Web Site: http://www.maxwell.af.mil/au/afiadl/operation/xferguid_fr.htm 

 
 
Once you have installed the FTP program, you are ready to send your batch files to AFIADL. 
Follow the instructions on the next page to use the FTP program to send your data to AFIADL. 
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Sending Data to AFIADL Using FTP 
 

Note: Do not attempt this unless you have first installed the FTP software! 
 
 

How To Send Files to AFIADL Using FTP 
Step Action 
1 Get the floppy disks with batch files. 

� You created this in the Using Answer Sheet Manager section. 
2 Run the FTP client software. 

� Select Start, then Browse, then select the file ws32ftp.exe, then OK 
� Click on the on-screen Icon (if applicable) to start the program. 

3 Insert the batch file disk in the drive. 
� Copy the files from the batch file diskette to the AFIADL FTP site shown 

below.  
� Copy all of the files that the Answer Sheet Manager Program listed when you 

created the disk. 
� Do not copy any other files. 

4 Enter the following data in the appropriate areas of the FTP program 
Hostname: 132.60.202.90 
Username: tcf 
Password: upload 

5 When the transfer is complete, exit the FTP client software. 
  
 
If you have problems using the FTP software: Click the link below:  
 
http://www.maxwell.af.mil/au/afiadl/operation/xferguid_fr.htm 
 
� This link includes a more detailed discussion and instructions on both the Answer Sheet 

Manager process and the FTP process. 
 
Once you are done, you may delete the files on the two diskettes used in the process. These diskettes 
do not need to be retained as backups. They may then be reused the following day. 
 
 
 
 
That’s it! You have successfully installed the program, become an administrator, added 
students, administered and scored tests, and sent data to AFIADL. 
 
The remaining sections of this Guide cover other CerTest related actions that you may or 
may not need to perform. 
 
However, before we get to those, here’s a quick checklist for a test session that you may find 
useful.  
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Checklist for Test Control Officers 

 
� 1. Log into CerTest as a program manager. 
 
� 2. Make sure you have the most current tests and that you’ve disabled any test bank questions (if 

applicable) by visiting the AFIADL Web Site at: 
http://www.maxwell.af.mil/au/afiadl/operation/certest.htm 

 
� 3. Add the student into the CerTest program (See How to Add a Student on page 21). 
 
� 4. Unlock the applicable Course Exam (See How to Unlock a Test on page 25). 
 

This step is absolutely critical if the student is retaking an exam previously failed. To 
accurately collect the data that will ultimately be sent to AFIADL, the student must take the 
retake exam using the same computer used previously or you must copy the student’s record 
to a diskette and copy it into the new computer before the student takes the retake exam. For 
help performing this task see "How to Copy Student Information to/from a Diskette." 

 
� 5. Print and have the student read and sign the Special Instructions to Computer-Based Testing 

Students. 
 
� 6. Have the student log-on to the computer using his/her Social Security Number and the 

password you provide. 
 
� 7. The student takes the applicable exam.  
 

Reminder: When the student completes the exam, you (the TCO) must directly 
observe the test being scored after entering your exit password. 

 
� 8. Print one copy of the test summary and give it to the student (see page 33). 
 

Test Failures. If the student fails the exam, schedule the student to retake the exam in 
accordance with AFIADL's established policies and procedures. The retake exam is already 
on the PC where CerTest is installed so you do not have to wait for a new exam to be sent. 

 
� 9. Copy the required student data files to a diskette, batch the files using the Answer Sheet 

Manager Program, and then send them to AFIADL using the File Transfer Program. (See "How 
to Download and Send Student Test Results to AFIADL" found on pages 37-44 of this guide). 
 

� 10. File the Special Instructions to Computer-Based Testing Students form discussed earlier.  
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How to Handle Question Challenges 
 
To Print, Download, or Delete Question Challenges: 
 

Step Action 
1 Select File (menu bar). 
2 Select Print/Download Question Challenges.  

 
The Print/Download Question Challenges window appears.  
 
You may restrict the Question Challenges that you print, download or delete by: 
� Selecting a date range and/or  
� Selecting a test number range.  

 
If you do not select a date range or test number range: 
� All Question Challenges in the Question Challenge database will be printed, 

downloaded, or deleted. 
 
 
Printing Question Challenges: 
 

Step Action 
1 From the drop down File menu: 

� Select Print/Download Question Challenges. 
2 Enter a date range and/or test number range to restrict the number of challenges 

you print. 
3 Click the Print button. 
4 Click the printer icon button to send the challenges to the printer; or, use the other 

buttons on the toolbar to browse the challenges on screen. 
 
 
Downloading Question Challenges to Disk: 
 
You may download some or all of the Question Challenges to a text file. 
 

Step Action 
1 From the File menu: 

� Select Print/Download Question Challenges 
2 Enter a date range and/or test number range to restrict the number of challenges 

you download to the text file. 
3 Click the Download to Disk button. 
4 � Select a name for the text file and a path to where you would like it to be 

saved 
� Then click OK.  

o The default file name is CHALLENG.TXT.  
o If the file already exists, you will be asked if you would like to append 

the Question Challenges to the end of the existing file. 
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Deleting Question Challenges from the Database: 
 
Once you have printed and/or downloaded the Question Challenges and reported the valid ones to 
the CerTest point of contact, you may wish to remove them from the database. 
 

Step Action 
1 From the File menu: 

� Select Print/Download Question Challenges. 
2 Enter a date range and/or test number range to restrict the number of challenges 

you delete. 
3 Click the Delete button. 
4 When prompted to confirm permanently deleting the challenges from the database, 

click YES.  
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How to Download New or Revised Tests 
 
New or revised tests are posted to AFIADL’s Web Site quarterly (Jan, Apr, Jul, Oct) as tests are 
revised and new customers start using the CerTest program.  
 
Download new or revised tests from: http://www.maxwell.af.mil/au/afiadl/operation/certest.htm  
 
Once you have downloaded the update file from the AFIADL web site, follow the instructions for 
copying them to diskettes. The diskettes you create as the result of the download process are used to 
update the CerTest files. 
 

Caution:  Each new or revised test must be copied into each computer that has the 
CerTest program loaded on it unless you are running CerTest on a Network. 

 
 
To Copy a Test from a Diskette: 
 

Step Action 
1 Log into the CerTest Program. 
2 From the File menu select 

� Copy From Diskette 
3 On the Copy From screen: 

• Select Test from the List Files of Type drop-down list box. 
• Select the drive containing the source diskette from the Drives drop-down 

list box. 
• Select the Directory. 
• Select the source file name from the File Name list 

4 Select OK. 
5 If more than one test was copied into the selected file,  

� Select the tests you want to copy in the Copy Tests into CerTest list box.  
 
Select Copy.  
 
If a test already exists in CerTest: 
� You will be asked if you want to replace the existing test.  
� Always select Yes if the date is newer than the existing date on the existing 

test. 
6 Select OK in the Copy Complete information box. 

 
 
 
Helpful Hint: 
 
If you start this process with Open Test List, CerTest will automatically select Test in the List Files 
of Type field, allowing you to skip this entry in step 3 above. 



Test Control Officer’s Guide                                                        AFIADL CerTest 

 52             February 2003 

How to Disable a Question 
 
This feature allows test control officers to disable a test question without having to replace the entire 
test.  
 
To disable a question, you must have the Disable Code for that specific question.  
 
Any disabled questions are posted to AFIADL’s Web Site quarterly (Jan, Apr, Jul, Oct) to minimize 
the number of times you have to visit the Web Site. The posting includes the test number, the 
question identification number, and the applicable disable code 
 
The Web Site address is http://www.maxwell.af.mil/au/afiadl/operation/certest.htm 
 

Step Action 
1 Log into the CerTest Program 
2 Select File 

� Then Select Open Test List. 
3 Highlight the desired test. 
4 Select View (menu bar). 
5 Select Test Specs. 
6 Select Disable Question. 
7 Enter the Question ID of the question you need to disable,  

� Then select OK. 
 
The Question ID is the test number, the section number, and the question number 
separated by periods.  
 
For example, the Question ID for the third question in section 5 of test 8533 is 
8533.5.3. 

8 Enter the Disable Code provided to you by AFIADL. 
Then select OK to disable the question. 
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How to Change the Test Validation Code 
 
Once a student has answered all of the questions in a test and chooses to score the test, the 
following dialog box is shown. This box requires the test control officer to enter his/her test 
validation code. If this test validation code is not entered correctly, the test cannot be scored. This 
feature prevents a student from scoring the test without the test control officer being present.  
 
The test validation code is simply your log-in password. Any CerTest manager's log-in password will 
work as a test validation code. 
 

 
 
This feature may be disabled but the TCO validation code is required to be entered on all AFIADL 
final exams to maintain test security and as an extra-added safety measure just in case there’s a 
computer malfunction when the test is being scored. 
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How to View a Test Summary 
 
The Test Summary screen is used to view the details of one of the tests an individual student took. It 
indicates how a student scored on the test. 
 
The Test Summary contains: 
� The student's score 
� The passing score for the test 
� Whether or not the student passed the test 
� Number of questions presented and the number correct for each section of the test 

 
To View a Student Record 

The Student Record screen displays the student's CerTest profile. 
 

Step Action 
1 Open the Student List. 
2 Highlight the name of the student whose record you want to view. 
3 Select View from the menu bar. 
4 Select Student Record. 
5 The Student Record screen displays.  

This screen displays the student's test profile which includes: 
� Student's Specialty 
� What tests the student is authorized to take 
� Each test's statistics 
� The student's test score, the test score's date, and the number of times the 

student took the test 
6 Press CTRL + S to exit the record. 

 
Helpful Hints: 
 
� Double clicking on a student replaces steps 2 through 4. 
� Pressing the Enter key replaces steps 3 and 4. 
 

How to View a Detailed Test Record 
 

Step Action 
1 Open Student List. 
2 Highlight the student’s name whose test results you want to view. 
3 Select View from the menu bar. 
4 Select Student Record. 
5 Highlight the test that you want to view on the Student Record. 
6 Select View from the menu bar. 
7 Select Detail. The Test Summary screen appears. 
8 Select Cancel to exit when you are finished viewing. 
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Sample Student Record 
 

MSgt Carruthers, Joe      000-00-0000 
 

Test    Title                          Stat   Score        Date      Atmpts 
9001 (CDC 3E731G) Firefighter I     
9003 (CDC 3E751G) Firefighter II     
9005 (CDC 3E751K) Airport Firefighter     
9010 (CDC 3E751H) Driver Operator – Pumper     
9011 (CDC 3E751J) Driver Operator – ARFF     
9012 (CDC 3E751I) Driver Operator – Aerial     
9013 (CDC 3E751L) Driver Operator – Tiller     
9020 (CDC 47201G) Hazardous Materials Awareness P 91 28 Jan 00 1 
9021 (CDC 47202G) Hazardous Materials Operations     
9022 (CDC 47203G) Hazardous Materials Technician     
9023 (CDC 47205G) Hazardous Materials Incident Cmdr     
9030 (CDC 57170G) Fire Officer I     
9031 (CDC 57170K) Fire Officer II     
9032 (CDC 10213G) Fire Officer III     
9033 (CDC 10214G) Fire Officer IV     
9040 (CDC 57170H) Fire Service Instructor I     
9041 (CDC 10412G) Fire Service Instructor II     
9042 (CDC 10413G) Fire Service Instructor III     
9050 (CDC 10311G) Fire Inspector I     
9051 (CDC 10312G) Fire Inspector II     
9052 (CDC 10313G) Fire Inspector III     
 
 

P = Passed    F = Failed 
 
 

For official use only. This information is subject to the Privacy Act of 1974. 
 
 
 
 
28 January 2000                  CerTest 
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How to Print a Student Record 
The Print function allows you to print a hard copy of a Student Record. 

 
Step Action 
1 Open the Student List. 
2 Double-click on the student whose record you want to view/print.  

The Student Record screen displays. 
3 Select File from the menu bar. 
4 Select Print. 

 
Report Format box displays. 

5 Click on the Display Social Security Number check box if you do not want the 
student's Social Security Number to appear on the printout. 

6 Print Full Record, Organized by 
Training Area. 

Prints all the posttests in the student's 
record, organized by Training Area.  
 
Any Filter/Sort options are ignored when 
printing using this option 
 

 Print Record as Currently Displayed  Prints only those tests that are displayed 
as a result of the current Filter/Sort 
options.  
 
This print will be limited to the selected 
Training Area (if not All Training Areas). 

7 The Print Preview screen displays. 
 
Select the printer icon from the tool bar at the top of the screen. 

8 Select Print Range. (The default is all pages.) 
9 Input number of copies. (The default is 1.) 
10 Select OK. The Student Record screen displays. 
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 How to Copy Student Records 
 
Copying student records to and from a diskette is absolutely critical if the student is retaking an 
exam he/she failed previously. To accurately collect the data that will be sent to AFIADL, the 
student must take the retake exam using the same computer used previously or you must 
copy the student’s record to a diskette and copy it into the new computer before the student 
takes the retake exam. The necessary steps to accomplish this task are provided below. 
 
To Copy a Student Record to Floppy Disk 
 

Step Action 
1 Open Student List 
2 Highlight the student(s) to copy. 
3 Select Copy To Diskette (File pull-down menu). 
4 Select Yes in the Copy Student(s) box. 
5 In the Copy Student(s) To box: 

• Select the drive containing the target diskette. 
• Select the Directory. 
• Input the file name in the File Name text box. 

6 Select OK. 
7 Select OK in the Copy Complete Information box. 

 
 

NOTE:   
Do not send this data to AFIADL.  
 
Use the Download ECI Data option to download the information that AFIADL requires. 

 
 
Helpful hint 
 
You may copy more than one student record at a time by selecting multiple records. To select a 
block of student records, highlight the first student in the block then press and hold the SHIFT key 
while clicking on the last student in the block. To select multiple student records that are not in 
sequence, press and hold the CTRL key while clicking on each record you want to copy. 
 
Additional information 
 
Student files have an extension of .std. When you copy student files to a diskette, a text file is also 
created on the diskette. This text file has the same name as the student file, but has a .txt extension. 
The text file contains a list of all students copied into the student (.std) file and may be viewed using 
Windows® Notepad. 
 
You may want to copy a student record from a diskette in order to reinstall a student who has been 
deleted from the CerTest system or to move a student from one computer system to another. If a 
student record is corrupted, the student should be deleted before the record is copied to the system 
from a diskette.  
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If you copy a student’s data from a diskette and the student already exists in the system, you will be 
given the option to merge the record on the diskette with the record on the system. The new student 
record on the system will contain a history of when each test was taken, but will contain a summary 
of only the most recent time each test was taken. 
 
To Copy a Student Record from Floppy Disk 
 

Step Action 
1 Select Copy From Diskette (File pull-down menu). 
2 On the Copy From screen: 

• Select student from the List Files of Type drop-down list box. 
• Select the drive containing the source diskette. 
• Select the source file name. 

3 Select OK. 
4 If more than one student record was copied into the selected file, you must select 

the student record(s) you want to copy in the Copy Students Into CerTest list box.  
Select copy. 

5 Select OK in the Copy Complete information box. 
 
 
 
Helpful Hint: 
 
If you start this process with Open Student List, CerTest will automatically select Student in the List 
Files of Type field, allowing you to skip this entry in Step 2 above. 

 
 
 

Downloading Previously Downloaded Data 
 
If for some reason you need to download AFIADL data for a test session that has already 
been downloaded previously: 
 
1. Select Download ECI Data from the File menu. 
  
2. Select View Previously Downloaded Data. The list will now show all test sessions that have been 
downloaded in the past 90 days. 
  

NOTE:  CerTest does not retain the AFIADL data for longer than 90 days. 
  
3. You may now select the test session you wish to download, and select Download. 
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How to Backup CerTest 

 
Backing up the CerTest system ensures having a copy of CerTest with all tests and student records in 
the event that your computer crashes or that your network or hard drive becomes corrupted. The 
system should be backed up at least once a week, more often if there are frequent changes in tests or 
student records. 
 
 

Step Action 
1 From File 

� Select Backup CerTest System. 
2 Select the type of CerTest Backup you wish to make: 

NOTE: Site Specific Backup is the recommended selection. This 
option makes a backup of all student data, current statistical data, 
managers, and site-specific tests and graphics. 

3 On the Backup CerTest System To screen: 
 
Select: 

• the target drive from the Drives drop-down list box  
• the Directory 

NOTE:  You may not change the file name of the backup file: 

Site Specific Backups must be named CTBACKUP.001 

4 Select OK. 
5 If necessary, respond to any information boxes that appear. 
6 Select OK in the Backup Complete box. 

 
 
Additional Information: 
 
To restore from the backup diskettes you create, select Restore CerTest System. 
 
In addition to the backup file, CerTest creates a text file that contains the date of the backup, the 
name of the Site and Station from which the backup was made, and the CerTest version number. For 
Site Specific Backups, this file is named CTBACKUP.TXT. 
 

NOTE: The Backup CerTest option does NOT backup archived statistical data. 
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Helpful Backup Hints: 
 
� If you are backing up the system onto disks, be sure to have several high-density disks ready 

to store the backup files. 
 
� If you are running CerTest on a network, you may not need to use the Backup CerTest option. 

Check with your network administrator about how your network is backed up. Networks 
often have a tape backup system. If your network is frequently backed up, you should not 
need to use the Backup CerTest option. 
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General Information and Requirements 
 
 
Users Guide All documentation and help for the CerTest Windows version is on-line. If you’re not 

sure how to do something, simply use the Help pull-down menu to receive 
information or instructions on the topic you need help with. In addition, instructions 
for the more common tasks are included in the Appendices section of this guide. 

Program 
Management 

CerTest may be installed on more than one computer. Computers loaded with CerTest 
must be in a location where the TCO can control their use. Loading instructions are 
found on page 12 and on the CerTest CD-ROM as a readme.txt file. 

Question 
Randomization 

Each CerTest exam has a bank of questions from which the final exam is drawn. For 
example, test 9003 (Firefighter II) has a 209 questions test bank, but only 115 
questions are used on the final exam. Additionally, the questions are randomized on 
the computer screen. For example, the same question might show on two computers 
at the same time, but answers are in a different order. The correct answer on 
Computer #1 is “a” and the correct answer on Computer #2 is “d.”  This is a built-
in security feature designed to minimize the potential for a test compromise. 

Bookmark 
Feature 

Students find the bookmark feature very useful. When taking a test, the student can 
bookmark a question and return to it later before exiting and having the test scored. 
For more bookmarking information see “How to Bookmark a Question” in the 
Student Guide. 

Moving Within a 
Test Using the 
Scroll Bar 

Another helpful feature is the scroll bar in the bottom right-hand corner of the test 
screen. This allows the student to move forward or backward one or more questions 
at a time. For example, a student is completing a 60-question test but would like to 
review questions 5, 12, 39, and 52 before exiting the test. The student can quickly 
review these questions by using the scrolling bar or the bookmark feature. For more 
information see “Moving Within a Test” in the Student Guide. 

CerTest Spell 
Checker 

CerTest has a powerful spell checker. However, this feature is disabled in the 
AFIADL version because fill-in-the-blank questions are not used. 

Program Errors If a program error occurs, write down the information exactly as it appears on the 
computer screen, and then contact the AFIADL Help Desk via e-mail at AFIADL 
customer service@maxwell.af.mil. If possible, before reporting a problem, see if you 
can duplicate the error and capture the sequence of keystrokes made when the error 
occurred. Please include both your commercial and DSN phone number. 

Test Control 
Facilities 

A centralized testing facility is recommended for using the CerTest program. The 
TCO must be able to monitor all computers at one time while official CDC testing is 
in progress. The facilities selected for computer-based testing must be conducive to 
continuous surveillance by a TCO. The TCO must ensure favorable testing 
conditions such as proper lighting, temperature, and freedom from distractions.  

Computer 
Hardware 

Please position the CPU and all power supply cords so they are not accessible by the 
student. This will avoid potential problems and prevent students accidentally kicking 
power supply cords or turning off the CPU power.  

Statistical Data CerTest automatically collects data used to validate the test. Data collected includes: 
� Student’s test results 
� Each student’s electronic answer sheet 
� Cumulative statistical data about the tests taken 
� Any question challenges 
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Testing Policies and Procedures 
 

Students A student must be prepared to sit through a test until the test is 
completed. 

Time Limits The test session will not exceed 3 hours, the same guideline for AFIADL 
paper tests. 

Tutorial CerTest has a built in tutorial. Most students taking computer-based tests 
will be familiar with the use of CerTest and will probably not elect to take 
the CerTest tutorial. If a student decides to take the CerTest tutorial, the 
time used to take the tutorial should not be counted as part of the 3-hour time limit. 

Challenging a Question CerTest has an on-line question challenge form. While taking a test, a 
student may find a question that he/she believes to be erroneous or 
invalid for some reason (i.e., typo, spelling mistake, missing graphic, 
ambiguous question, etc.). The student may challenge the question by 
clicking on the hand icon located in the top right-hand corner of the 
toolbar, or by selecting “Challenge this Question” from the Help menu. 
If a student has a concern about the accuracy or clarity of a question, 
he/she must challenge the question during the test session and the 
student’s comments must be as detailed as possible. Warning:  No copy of 
the test question will be made by the examinee nor should one be kept on file. All 
question challenges are automatically sent to AFIADL when you FTP the 
required student data files. The information collected is equal to the 
student filling out an ECI Form 17. For further information see “Test 
Question Challenges,” page 22. 

Passing Score   
 

The passing score for all AFIADL CDC exams including CerTest is 65 
percent. 

Test Failures If a student fails the test, provide the student with a hard copy of the 
"Test Summary" (shows the learning objective(s) that require further 
study). Anyone failing a test should restudy before taking the test a 
second time. See page 34 for further details. The “Test Summary” form is 
set up very similar to an ECI Form 9. 

Recordkeeping When the student completes the test, print one copy of the “test 
summary” and give it to the student. If you need a copy of the test 
summary at a later date, you can recall it by entering the Student Record 
section and selecting the “Detail” option under the “View menu” or by 
double clicking on the Stat, Score, Date, or Attempts block for that 
particular test. 

 
 
CerTest Question Types 
 
As a test development program, CerTest has the flexibility to use up to seven different question 
formats or variations. However, not all of these question formats are used in the AFIADL version. 
We have elected to restrict most CDC/SC course exams that use CerTest to four-option multiple 
choice questions just like we use for our paper-based CEs. Where graphics are required for a 
question, they are also included with the CerTest version. 
 
 
 
 



AFIADL CerTest                                     Test Control Officer’s Guide 

February 2003                     63            

 
Test Interruptions 
 
Ideally, once a student logs on to the computer to take a test, his or her session should be 
uninterrupted. However, there are times when disruptions occur. For example, in the event of a fire 
alarm or other emergency, the TCO and student should follow the appropriate emergency response 
procedures. 
 
In the event of a power outage, the student (without penalty) will be allowed to retake the same test 
as soon as possible. It is preferable for the test to be re-administered as soon as the power comes 
back on. However, if time does not permit, a new test session should be scheduled. 
 
Should a computer error prevent a student from completing a test, or a test from being scored, 
document the error and steps leading to the error and then (without penalty) allow the student to 
retake the test. 
 
Students will not be penalized for events beyond their control. Should a test session be interrupted, 
the TCO will print the student’s test summary and document the circumstances that caused the 
interruption and notify AFIADL Data Branch. 
 
Score Button 
 
At the end of the test, a score button and message will appear. You must follow the procedures as 
stated in the message: 
 

To score this test, the test control officer must input a password. If you are ready to 
exit and score your test, call the test control officer over to your computer now. Press 
Cancel to continue reviewing your test. 

 
If for some reason a student leaves any questions unanswered, the following message will appear. 
 

You have left XX questions unanswered. Select OK to exit this test anyway (your 
unanswered questions will be counted as wrong); or select Cancel to continue 
working on this test. 

 
Bookmarked Questions 
 
If the student has bookmarked a question the following message will appear. 
 

You have a bookmarked question. Select OK to exit this test anyway; or select Cancel 
to continue working on this test. 
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The Process 
 

1 A student enrolls in an AFIADL course with a CerTest exam and studies the required 
training material. 

2 The first time a student enrolls in a course with a CerTest exam and identifies your TCF, 
you are sent a CD that includes the Test Control Officer's Guide, all CerTest-based course 
exams, and other software needed for the program, as well as notice of the student's 
eligibility for an exam (just like your paper tests). After the initial CerTest exam enrollment 
for your TCF, you will NOT receive additional CDs because all of the tests are included 
on the CD you originally received. For initial and subsequent CerTest exam 
administration, ensure that you do not overlook the following step. 

3 Make sure that you have the current exams. New exams, revised exams and notice of 
disabled questions are posted quarterly (Jan, Apr, Jul, Oct) on the AFIADL web site at 
http://www.maxwell.af.mil/au/afiadl/operation/certest.htm 
When updates are posted, notices will be placed on the "News" pop-up box on the 
AFIADL opening page as well as the "What's New" tab of the AFIADL web site. 

4 When you have verified that you have the current exam, notify the student (using existing 
procedures) that the CE is available and schedule a time for the student to take the test. 

5 The student reports to TCF for scheduled testing. 
6 The TCO adds the student to the CerTest program and also unlocks the applicable CE. 

(See pages 21-26 of this guide). 
Note:  When you add a new student, use a password that is easy for you to 
remember (i.e., the letter “a” or the student’s first and last initial). Any password 
you choose to use to simplify the process is acceptable. 

7 Have the student read and sign the Special Instructions to Computer-Based Testing 
Students. 

8 The student logs-on to the testing computer using his/her actual Social Security Number 
and the password you’ve provided. 

9 The student takes the applicable test. When the student answers the last question, he/she 
will be asked if he/she wants to exit and score the test. The student has the option of 
selecting "No" and reviewing the test. When the student selects "Yes" the TCO/test 
proctor must complete the actions in Step 10. 

10 Before exiting and scoring the test can be done, the student must have the TCO 
enter the validation code. Once the validation code is entered, the test can be 
exited and scored. The test control officer must directly observe the test being 
scored. 

11 Print and give one copy of the “Test Summary” to the student. (See pages 30-33) 
12 If the student fails the CE, the “Test Summary” will show the learning objective(s) that 

require further study (see page 32). Anyone failing a CE will have the opportunity to 
restudy before taking the CE a second time. The student's retake must be scheduled 
within 30 days. 

13 Send the test results to AFIADL. (See page 44 for specific instructions) 
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